
 

 

 

 

                                                                                              

Development of Web service using

RATIONAL DEVELOPER FOR POWER 

Objectives 
 
The hotspot in the current IT world is optimized Web Services. Now the 
enterprises have started 
Services. This white paper gives Information for the business managers 
and engineers in developing and deploying Web Services using Rational 
Developer for Power System (RDP) and Web Sphere Application Server 
(WAS), respectively. This paper explains the steps to create Web Service 
using RDP. 
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What are Web Services?
 
Web Services are relatively a new technology that implements service
The development of this technology, involves a major 
accessible over standard Internet protocols that are independent from platforms and 
programming languages. Web Services are self
described, published, located and invoke
functions, ranging from a simple request
new or wrapped around existing applications.
 
 
What are the Key Benefits of Web Services?
 

• Reusable Application Components
• Connecting Different Applications/Software
• Web Services are self-
• Web Services are self-
• Web Services can be published, located and 

invoked across the Web
• Web Services are modular
• Web Services are language 
• Web Services are inherently open standard
• Web Services are loosely coupled
• Web Services are dynamic
• Web Services provide programmatic access
• Web Services enables to integrate already existing and new applications

 
 
Overview of RDP and IBM i Web Service and Java Tool
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IBM I Web development tools give you the ability to create new e
business applications that use a Web
communicate with the business logic in an ILE or non
language program residing on an I
 
IBM I Web services are self contained, modular application that 
can be described, published, located, and invoked over the 
Internet, employing ‘just-in-time’ integration of services.
 
The Web Service wizard creates a Bottom up IBM i Program 
Service, with Web service operations that call one or more server 
programs or service program procedures on IBM i.
 
The Web Service wizard works in the context of a Web project 
and allows for creation, deployment, testing, generation of a 
proxy, and publication to a Universal Description, Discovery, and 
Integration (UDDI) registry of Web service.

                                                                                              

What are Web Services?  

Web Services are relatively a new technology that implements service
The development of this technology, involves a major focus on making functional building blocks 
accessible over standard Internet protocols that are independent from platforms and 
programming languages. Web Services are self-contained, modular applications that can be 
described, published, located and invoked over networks. Web Services encapsulate business 
functions, ranging from a simple request-reply to full business process interactions and can be 
new or wrapped around existing applications. 

What are the Key Benefits of Web Services?  

Application Components 
Connecting Different Applications/Software. 
Web Services are self-contained 
Web Services are self-describing 
Web Services can be published, located and  
invoked across the Web. 
Web Services are modular 
Web Services are language independent and interoperable 
Web Services are inherently open standard 
Web Services are loosely coupled 
Web Services are dynamic 
Web Services provide programmatic access 
Web Services enables to integrate already existing and new applications

RDP and IBM i Web Service and Java Tool

IBM I Web development tools give you the ability to create new e-
business applications that use a Web-based front end to 
communicate with the business logic in an ILE or non-ILE 
language program residing on an IBM i server. 

IBM I Web services are self contained, modular application that 
can be described, published, located, and invoked over the 

time’ integration of services. 

The Web Service wizard creates a Bottom up IBM i Program Web 
Service, with Web service operations that call one or more server 
programs or service program procedures on IBM i. 

The Web Service wizard works in the context of a Web project 
and allows for creation, deployment, testing, generation of a 

blication to a Universal Description, Discovery, and 
Integration (UDDI) registry of Web service. 
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Web Services are relatively a new technology that implements service-oriented architecture. 
focus on making functional building blocks 

accessible over standard Internet protocols that are independent from platforms and 
contained, modular applications that can be 

d over networks. Web Services encapsulate business 
reply to full business process interactions and can be 

Web Services enables to integrate already existing and new applications 

RDP and IBM i Web Service and Java Tool  

 



 

 

 

 

                                                                                              

Steps of Creating Web Service using RDP
 
Follow the Steps as shown in the screen shot and read the description for better understanding.
 
Open Server Window  
 

                                                                                              

Steps of Creating Web Service using RDP  

Follow the Steps as shown in the screen shot and read the description for better understanding.

 

 

 

Click on the Server. It will open the WAS Server 

which are install on it. As shown in the Figure 

above  
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Follow the Steps as shown in the screen shot and read the description for better understanding. 

 

t will open the WAS Server 

which are install on it. As shown in the Figure 



 

 

 

 

                                                                                              

Start Server 

 

Setting Up Server – Step 1

 

                                                                                              

Step 1 
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Right Click  on the 
selected server and Click 
on Start  as shown in 
figure. 

 Note: When you start the 
server it might take several 
minutes to be start 

Start its status would be 
Started  

 

 

 

 

 

 

Install a RAR file  

In the Servers view, Right-
click  the started server, 
and then select 
Administration  > Run 
administrative console .  

Enter User ID  and 
Password  if necessary.  

 



 

 

 

 

                                                                                              

 

 

 

 

 

 

 

 

 

 

 

Install a RAR file  

In the left panel, expand Resources

Select Node=node  name in the Scope list.

Click Install RAR  to install a new RAR file. Click Browse in Local path to locate and select 

Program Files\IBM\SDPShared\plugins

Change the name to IBM i Program Call Resource Adapter

Click OK and then Save for directly save into master configuration.

                                                                                              

Resources  > Resource Adapters  and click Resource adapters

name in the Scope list. 

to install a new RAR file. Click Browse in Local path to locate and select 

plugins\com.ibm.etools.iseries.webtools.ae_version\lib

IBM i Program Call Resource Adapter  in the Name field, and

for directly save into master configuration. 
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Resource adapters .  

to install a new RAR file. Click Browse in Local path to locate and select  

lib\iseriespgmcall.rar 

in the Name field, and then click OK.  



 

 

 

 

                                                                                              

Setting Up Server – Step 2

Click OK. Then Click Save to save directly to the master configuration
Note: The USER ID and PASSWORD
IBM i system  for the program call. 

                                                                                              

Step 2 

to save directly to the master configuration                                               
PASSWORD that you specify in the JAAS authentication entry are used for signing on to the 
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Defining the connection 
factory  

Create JAAS 
authentication entry  

In the left panel, expand 
Security  and click secure 
administration , 
applications, and 
infrastructure .  

In the Authentication 
section , expand Java 
Authentication and 
Authorization Service  
and click J2C 
authentication data .  

Create JAAS authentication 
entry  

 Click New to create a new JAAS 
authentication entry.  

 Enter a name in the Alias  field 
that represents the alias name of 
the JAAS login configuration for 
the role-based authorization for 
J2EE resources.  

 Enter an ID for the JAAS login 
configuration in the User ID  field. 

 Enter a password for the JAAS 
login configuration in the 
Password  field. 

Enter a description for the JAAS 
login configuration in the 
Description  field.  

                                                                             
that you specify in the JAAS authentication entry are used for signing on to the 



 

 

 

 

                                                                                              

Setting Up Server – Step 3

Create a J2C connection factory

• In the left panel, expand 
adapters .  

•   Click the resource adapter name: 

•   In Additional Properties

•   Click New to create a new 

•   Enter a name for the connection factory in the 

•   Define the JNDI name by entering the name in the 
enter a name in the form eis/name.

•   Select the alias name, which you defined on the Security page in the JAAS 
Authentication Entries area, from the list for 

  Select the same alias name as in the previous step from the list for 
authentication  alias. 

Click OK to create the connection factory. 
configuration. 

 

                                                                                              

Step 3 

Create a J2C connection factory  

In the left panel, expand Resources  > Resource Adapters  and click 

Click the resource adapter name: IBM i Program Call Resource

Additional Properties  section, click J2C connecti on factories

to create a new J2C connection factory .  

Enter a name for the connection factory in the Name field.  

Define the JNDI name by entering the name in the JNDI name  field. For example, 
enter a name in the form eis/name. 

Select the alias name, which you defined on the Security page in the JAAS 
Authentication Entries area, from the list for Container- managed authentication

Select the same alias name as in the previous step from the list for Component

to create the connection factory. Then Click Save to save directly to the master 
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and click Resource 

IBM i Program Call Resource  Adapter you created. 

on factories .  

field. For example, 

Select the alias name, which you defined on the Security page in the JAAS 
managed authentication  alias.  

Component -managed 

to save directly to the master 



 

 

 

 

                                                                                              

Setting Up Server – Step 4

 

 

Define resource properties associated with the conn ection factory

•   Click the connection factory 

•   In Additional Properties
ServerName , UserName
ServerName  is a mandatory property. Click the 
enter its value in the Value
whose value is provided by the JAAS alias. 

Click OK.  Then Click Save to save directly to the master configuration. 

Note: after this close Admin panel and back 

 

                                                                                              

Step 4 

Define resource properties associated with the conn ection factory  

Click the connection factory name that you created.  

Additional Properties  section, click Custom properties . You should see 
UserName , and Password  in the Name column of the table. 
is a mandatory property. Click the ServerName  in the 

Value  field. UserName  and Password  are optional properties 
whose value is provided by the JAAS alias.  

to save directly to the master configuration.  

Note: after this close Admin panel and back REMOTE SYETEM EXPLORER 
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. You should see 
column of the table. 

in the Name column and 
are optional properties 

 



 

 

 

 

                                                                                              

Creating IBM I Web Service 

You can create a Web service from ILE RPG or COBOL source or from PCML files using the 
Web Service wizard. 

Start the application server before running the Web Service wizard.

From the Servers view (Window > Show View > Other > Server > Servers),
server in the list and select Start.

Right-click  the ILE RPG, COBOL, or PCML source object and select 
Web Service .  

If the library containing your source object is not in the library list, expand Objects, right
select Add Library List Entry, and enter the name of your library in the Additional library field.

The Web Service wizard opens and is populated with data from the source 
selected.  

 

 

                                                                                              

Creating IBM I Web Service – Step 1 

You can create a Web service from ILE RPG or COBOL source or from PCML files using the 

Start the application server before running the Web Service wizard. 

(Window > Show View > Other > Server > Servers),
server in the list and select Start. 

the ILE RPG, COBOL, or PCML source object and select Web Services

source object is not in the library list, expand Objects, right
select Add Library List Entry, and enter the name of your library in the Additional library field.

The Web Service wizard opens and is populated with data from the source 
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You can create a Web service from ILE RPG or COBOL source or from PCML files using the 

(Window > Show View > Other > Server > Servers),  right-click on a 

Web Services  > Create 

source object is not in the library list, expand Objects, right-click Library list, 
select Add Library List Entry, and enter the name of your library in the Additional library field. 

The Web Service wizard opens and is populated with data from the source object that you 



 

 

 

 

                                                                                              

Creating IBM I Web Service 

 

Creating IBM I Web Service 

                                                                                              

ating IBM I Web Service – Step 2 

 

ating IBM I Web Service – Step 3 

 

•   In the 
Bottom up IBM i Program Web 
Service
not, select it from the 
list .  

•   Click 
Select Service 
window. 

•   Ensure that the Program type is 
correct, especially if you are 
creating a 
ILE RPG or COBOL source file. 
Program type defaults to 
*SRVPGM
correct for your source file. 

 

 

 

 

• Click 
Runtime configuration
find authentication and runtime 
configuration values, or click 
to set them. See Configuring 
your IBM i Web Service runtime 
environment.

•  Ensure that the Program type is 
correct, especially if you are 
creating a 
ILE RPG or COBOL source file. 
Program type defaults to 
*SRVPGM
correct for your source file. 
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In the Web service  type field, 
Bottom up IBM i Program Web 
Service  should be highlighted. If 
not, select it from the drop-down 

 

Click Browse  to open the 
Select Service Implementation  
window.  

Ensure that the Program type is 
correct, especially if you are 
creating a Web Service  from an 
ILE RPG or COBOL source file. 
Program type defaults to 
*SRVPGM, which may not be 
correct for your source file.  

Click Browse  next to the 
Runtime configuration  field to 
find authentication and runtime 
configuration values, or click Edit  
to set them. See Configuring 
your IBM i Web Service runtime 
environment. 

Ensure that the Program type is 
correct, especially if you are 
creating a Web Service  from an 
ILE RPG or COBOL source file. 
Program type defaults to 
*SRVPGM, which may not be 
correct for your source file.  



 

 

 

 

                                                                                              

Creating IBM I Web Service 

 

•   Enter the Host IP Address

•   Enter User id  of IBM I Server to Login

•  Enter Password . 

Click on Finish   

Note: When you return to the Select Service Implementation window, click OK to set the values 
and to return to the first page of the Web Service wizard. 

 

 

                                                                                              

ating IBM I Web Service – Step 4 

 

Host IP Address  or Host Name  

of IBM I Server to Login 

Note: When you return to the Select Service Implementation window, click OK to set the values 
and to return to the first page of the Web Service wizard.  
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Note: When you return to the Select Service Implementation window, click OK to set the values 



 

 

 

 

                                                                                              

Creating IBM I Web Servic e 

Select the stages of the Web services development t hat you want to complete using the 
slider: 

 

•   Develop:  this develops the WSDL definition and implementation of the Web Service. It 
includes such tasks as creating modules, which will contain the generated code, WSDL 
files, deployment descriptors, and Java files when appropriate.

•   Assemble:  this ensures that 
associated to an EAR when required by the target application server. 

•   Deploy:  this creates the deployment code for the service. 

•   Install:  this installs and configures the Web module and EARs on the ta

•   Start:  this starts the server once the service has been installed on it. The server
wsdd file is generated. 

•   Test:  this provides various options for testing the service, such as using the Web 
Service Explorer or sample JSP files

•   The Server  option displays the default server. To deploy your service to a different 
server, click Server  and specify the server that you want to use. 

•   The Web service runtime
different runtime, click 
use.  

•   The Service project  
workspace. To specify a different project and EAR file, click the 
Ensure that the project selected as the 
Web Project , or the service will be overwritten by the client's generated artifacts. 

•   If you want to create a client, select the type of proxy to be generated from the 
type  list, and repeat the above slider steps for the client. 

•   Select the Publish the Web service check box
Services Explorer to publish your Web service to a UDDI registry. 

•   Select the Monitor the Web service check box
through the TCP/IP monitor, which allows you to watch the SOAP traffic generated by 
the Web service, and to test this traffic for WS
project. As an alternative, you can manually set up 

•   Either click Finish  to create the Web service or click 
options.  

                                                                                              

e – Step 5 

Select the stages of the Web services development t hat you want to complete using the 

this develops the WSDL definition and implementation of the Web Service. It 
includes such tasks as creating modules, which will contain the generated code, WSDL 
files, deployment descriptors, and Java files when appropriate. 

this ensures that the project that hosts the Web Service or client is 
associated to an EAR when required by the target application server. 

this creates the deployment code for the service.  

this installs and configures the Web module and EARs on the ta

this starts the server once the service has been installed on it. The server
wsdd file is generated.  

this provides various options for testing the service, such as using the Web 
Service Explorer or sample JSP files 

option displays the default server. To deploy your service to a different 
and specify the server that you want to use.  

Web service runtime  displays the default runtime. To deploy your service to a 
ick Web service runtime  and specify the runtime that you want to 

Service project  option displays the project containing the project selected in your 
workspace. To specify a different project and EAR file, click the Service project link

that the project selected as the Client Web Project  is different than the 
, or the service will be overwritten by the client's generated artifacts. 

If you want to create a client, select the type of proxy to be generated from the 
list, and repeat the above slider steps for the client.  

Publish the Web service check box  if you want to launch the Web 
Services Explorer to publish your Web service to a UDDI registry.  

Monitor the Web service check box  to send the Web service traffic 
through the TCP/IP monitor, which allows you to watch the SOAP traffic generated by 
the Web service, and to test this traffic for WS-I compliance of the specified Service 
project. As an alternative, you can manually set up a TCP/IP monitor. 

to create the Web service or click Next  to configure advanced 
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Select the stages of the Web services development t hat you want to complete using the 

this develops the WSDL definition and implementation of the Web Service. It 
includes such tasks as creating modules, which will contain the generated code, WSDL 

the project that hosts the Web Service or client is 
associated to an EAR when required by the target application server.  

this installs and configures the Web module and EARs on the target server. 

this starts the server once the service has been installed on it. The server-config-

this provides various options for testing the service, such as using the Web 

option displays the default server. To deploy your service to a different 

displays the default runtime. To deploy your service to a 
and specify the runtime that you want to 

option displays the project containing the project selected in your 
Service project link . 

is different than the Service 
, or the service will be overwritten by the client's generated artifacts.  

If you want to create a client, select the type of proxy to be generated from the Client 

if you want to launch the Web 
 

to send the Web service traffic 
through the TCP/IP monitor, which allows you to watch the SOAP traffic generated by 

I compliance of the specified Service 
a TCP/IP monitor.  

to configure advanced 



 

 

 

 

                                                                                              

Click the Finish button for create the Web service.  The Window will close once it creates 
successfully. IF found any error follow the steps 

 

 

 

 

 

 

 

 

 

 

                                                                                              

Click the Finish button for create the Web service.  The Window will close once it creates 
successfully. IF found any error follow the steps again 
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Click the Finish button for create the Web service.  The Window will close once it creates 



 

 

 

 

                                                                                              

Web Service Created 
the Project 

 

Testing/Running the Web Service

 

                                                                                              

Web Service Created – Running/Testing the Web Service Showing in 

Testing/Running the Web Service  

 

Click on the Navigator as shown in the 

Image 

For running the web service.
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Running/Testing the Web Service Showing in 

 

Click on the Navigator as shown in the 

 

For running the web service. 
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• There are showing two 
options. When you 
create the Web service 
through wizard. 

• The wizard creates two 
files. One Java beans 
and other the XML 
format. Try to test both 
you will get the idea of 
each option. 

• Both options generate 
the same output. But 
when you run from 
option one its generate 

• the form base output 
and other in the XML 
base. 



 

 

 

 

                                                                                              

Web Service Input 

Web Service Input /Output

 

 

Click on the Go button to invoke the web service to fetch the

the output. 

In the below image the output is 

                                                                                              

/Output  

to invoke the web service to fetch the data from the IBM I server and display 

In the below image the output is generated from the IBM I Server 
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he IBM I server and display 


